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Dear customer:

Thank you for choosing the Rosewill Ray6mini Laser Engraver!

Whether you're experienced with engraving machines or purchasing

one for the first time, we highly recommend reading this manual

carefully. The installation steps and safety precautions outlined here

will help you avoid unnecessary damage or frustration.

For more information, please refer to:

1. Email: techsupport@rosewill.com

2. Technical Support: 1-800-575-9885

3. Facebook ID : Rosewill

4. YouTube Channel: RosewillUSA
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Safety Precautions

(1) The Ray6mini engraves and cuts materials using a high-energy

diode laser beam. Hazards associated with this include the risk of

fire, the generation of hazardous and/or irritating toxic fumes, and

most importantly, potential damage to eyes and skin.

(2) Laser engravers are classified into several internationally

recognized classes based on their power and risk of injury. The

Ray6mini falls under Class IV (Class 4 according to IEC standards,

which align with the U.S. FDA classification).

Laser Class Class Definition

Class I Class I laser radiation is not considered hazardous.

Class IIa Class IIa laser radiation is not considered hazardous if viewed for

periods less than or equal to 1x10³ seconds, but may pose a chronic

viewing hazard if viewed for periods longer than 1x10³ seconds.

Class II Class II laser radiation is considered to be a chronic viewing hazard.

Class IIIa Class IIIa laser radiation is considered to be, depending on the

irradiance, either an acute intrabeam viewing hazard or a chronic

viewing hazard, and poses an acute hazard if viewed directly with

optical instruments.

Class IIIb Class IIIb laser radiation is considered to be an acute hazard to the

eyes and skin from direct exposure.
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Class IV Class IV laser radiation is considered to be an acute hazard to the skin

and eyes from both direct and scattered exposure.

The high-energy laser beam can cause severe eye injuries, including

blindness, and serious skin burns.

Improper use of controls or modification of safety features may

result in serious eye injuries and burns.

Please wear Personal Protective Equipment (PPE). Safety glasses are

designed to filter specific ranges of laser wavelengths. The

Ray6mini comes with safety glasses specifically designed for the

Rosewill Laser Module.

• DO NOT look directly into the laser beam.

• DO NOT aim the laser beam at reflective surfaces.

• DO NOT operate the laser without PPE for all individuals in the

vicinity of the Ray6mini.

• DO NOT allow unsupervised access to the Ray6mini by children.

• DO NOT allow pets near the Ray6mini.

• DO NOT modify or disable any safety features of the laser

system.

DO NOT touch the high-energy laser beam.
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(3)We strongly recommend placing the machine in a well-ventilated

room. Ensure that the door seals properly and the windows have

curtains to effectively prevent direct exposure to the laser beam,

smoke, vapors, particles, and other potentially toxic substances.

Additionally, you can consider Rosewill’s protective covers for

added safety in the future.

(4)The high-energy diode laser beam can generate extremely high

temperatures as it burns away material during engraving and

cutting. Some materials are flammable and may catch fire,

producing flames, fumes, and smoke.

(5)It is strongly recommended that a fire extinguisher be located

near the Ray6mini. The extinguisher should be halogen or

multi-purpose dry chemical. Additionally, it is advised to place a

'fire extinguisher ball' beside the Ray6mini, either as an

alternative or in conjunction with the fire extinguisher.

• DO NOT use materials that are highly flammable, explosive or

produce toxic by-products.

• DO NOT remove the material from the cutting bed before it has

cooled.

• DO NOT leave the Ray6mini operating unattended.
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• ALWAYS clean up clutter, debris, and flammable materials with

the laser Ray6mini bed after use.

(6)During the engraving process of the Ray6mini laser engraving

machine, different materials may produce different pungent

odors. Always use the Ray6mini laser engravers in open and

well-ventilated areas.

(7)Environmental requirements

The Ray6mini laser engraver operates best within a temperature

range of 10°C to 30°C and a humidity range of 20% to 50%.

Outside of these conditions, the engraver may not deliver

optimal engraving results.

(8)Below is a list of some of the most well-known hazardous

materials that SHOULD NOT be engraved or cut. If a material is

not listed, do not assume it is safe to use. Always obtain the

Safety Data Sheet (SDS) from the material’s manufacturer when

handling unknown materials.

Material Reason to avoid engraving / cutting it

PVC

(Polyvinyl

Chloride)

PVC emits chlorine gas when laser cut or engraved. This toxic gas

can damage the optics and motion control system of the laser

engraver. Engraving or cutting PVC will void the warranty of your

laser engraver.
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Lexan / Thick

Poly-

carbonate

Polycarbonate is often used in the laser engraver's window

because it effectively absorbs infrared radiation—the same light

frequency used by the engraver for cutting and engraving. This

makes the laser cutter ineffective at cutting polycarbonate

materials.

ABS

ABS melts when exposed to a laser beam instead of vaporizing,

which is the ideal reaction for laser engraving. As a result, ABS

doesn't leave a crisp image but instead creates a gooey deposit on

the surface.

HDPE
HDPE melts easily and is highly flammable when exposed to a laser

beam.

Polystyrene

Foam

Polystyrene melts and catches fire easily when exposed to a laser

beam, and only very thin pieces can be cut.

Fiberglass

Fiberglass consists of glass and epoxy resin. Etching is the best

method for marking glass, while epoxy resin emits toxic fumes

during laser engraving, making fiberglass unsuitable for laser

engraving.

Polypropylene

Polypropylene melts and catches fire easily, with the melted

material continuing to burn and forming pebble-like drips that

harden on the surface.

Coated Carbon

Fiber

Coated carbon fiber emits noxious fumes. While carbon fiber can

be cut with some fraying, this is not the case when it is coated.

(9)The Ray6mini has built-in technology and algorithms to ensure
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the safety of its users and the surrounding environment. That

said, it is important to understand that the Ray6mini is not a toy

and should be operated with care and respect.

(10) The labels on the laser module are shown as below:

LASER APERTURE
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DANGER − LASER RADIATION

AVOID EYE OR SKIN EXPOSURE TO DIRECT OR SCATTERED

RADIATION CLASS 4 LASER PRODUCT
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A.Product Information

1. Product Specifications

Features Features

Model Ray6mini Laser Power 2.5W/3.5W

Laser Source Single diode laser with FAC Laser Wavelength 450nm

Working Area 130*140mm Cutting Depth 12mm

Engraving Speed 12,000mm/min Engraving Precision 0.04mm

Support Formats jpg, bmp, png, dxf, svg, ai, tiff, etc. Lifespan 10000+hours

Warranty Period One year Material of Machine Aluminum alloy

Connection WI-FI, USB, APP Safety Certifications CE; FCC; FDA; RoHS

Supported Systems Windows; MacOS; Linux;Android;iOS Product Dimensions 286mm*292mm*165mm

Gross Weight 2.32kg Net Weight 1.47kg

Power Adapter AC Input 100-240V 50/60Hz 1.5A, DC Output 12V-2A 24W or 12V-3A 36W

Applicable Materials engraving or cutting on Wood, acrylic, leather, cloth, metal, ceramics, etc.
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2. Product Accessories List

Machine Frame Laser Module Power Adapter Data Cable

Protective Goggles Focus Block Wrench Wooden Brush
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3. Product Parts Overview
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B. Quick Installation

1. Install the Laser Module onto the X-axis Frame

（ 1） First install the laser module

onto the X-axis frame, then tighten

the M3*14 handle screw to secure it

in place.
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（2）Connect the cable to the laser

module as shown in the figure.
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2. Adjust the Focus

Loosen the M3*14 handle screw. Place the 2mm focus block on the engraving surface. Move the laser module
downward until the bottom of the light shield touches the surface of the focus block. Then, tighten the M3*14
handle screw.
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C. LaserGRBL Software Operation

LaserGRBL is an easy-to-use, fully free software designed specifically

for laser engravers, and it runs only on Windows. Please ensure to

save or back up your data regularly during use to avoid data loss.

However, Rosewill is not responsible for any data loss caused by

third-party software.

1. Software Download and Installation

Download LaserGRBL from the following link:

https://lasergrbl.com/download/. Then, click Next > Next > Install >

Finish to complete the installation.

https://lasergrbl.com/download/
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2. Connect Ray6mini to LaserGRBL

You need to connect the engraver to LaserGRBL software first. For

Windows, right-click This PC and select Manage, then click Device

Manager. Expand Ports (COM & LPT), find the port corresponding to

the CH340 driver, and select it from the COM port list. Set the baud

rate to 115200 baud rate, and click to connect.

When connected to the correct port, GRBL will reply with a

“welcome message” showing the GRBL firmware version. On the

bottom-right of the LaserGRBL interface, it will show “Status: Idle”.

If no ports are listed in the drop-down, it means no engraver was

found, which could indicate it's not plugged in correctly, is not

powered, or the PC is missing a driver. In that case, click the Tools

menu to install the CH340 Driver from LaserGRBL software.
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3. Main Interface of LaserGRBL

①Connection Control: Here you can select the serial port and set

the proper baud rate for the connection.

②File Control: This shows the loaded filename and the engraving

process progress. The green "Play" button starts program execution.

https://lasergrbl.com/usage/arduino-connection/
https://lasergrbl.com/usage/load-and-send/
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③Manual Commands: You can type any G-Code line here and press

"Enter." The commands will be added to the command queue.

④Engraving Preview: This area shows a preview of the final work.

During engraving, a small blue cross will indicate the current laser

position in real time.

⑤Jogging Control: Allows manual positioning of the laser. The left

vertical slider controls movement speed, while the right slider

controls step size.

⑥Grbl Reset/Homing/Unlock: These buttons send the soft-reset,

homing, and unlock commands to the GRBL board. To the right of

the unlock button, you can add custom user-defined buttons.

⑦ Pause and Resume: These buttons allow you to suspend and

resume the engraving process.

4. Connect Ray6mini to LaserGRBL via Wi-Fi

There are two modes for connecting the Ray6mini to LaserGRBL via

Wi-Fi: STA and AP mode. The difference is that in AP mode, the

computer has no network connection, while in STA mode, the

computer can maintain its network connection.

1) Connect Ray6mini to LaserGRBL via Wi-Fi

Run LaserGRBL, click Grbl > Settings, select Telnet for the

https://lasergrbl.com/usage/jogging/
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Connection Protocol， and click Save. Connect the computer to the

Wi-Fi network starting with LongerLaser_XXXX, input password

12345678, input the 192.168.0.1:8847 in IP:PORT, click to

connect.

2) Connect Ray6mini to LaserGRBL via Wi-Fi in STA Mode

Run LaserGRBL, click Grbl > Settings, select Telnet for the

Connection Protocol , and click Save. Enter the following commands
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in the console: $radio/mode=sta

$sta/ssid=Your_SSID

$sta/password=Your_PassWord

$wifi/begin

change Your_SSID and Your_PassWord to your WIFI account and

password in $sta/ssid and $sta/password command,Press Enter

after each command. Now you switch to STA mode. After the

connection is successful, the console prompts the the IP address.

Please note that the computer network and WIFI must be in the

same LAN (local area network). Input IP and port such as

192.168.1.101:8847 in IP:PORT, click to connect
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5. Create a Project in LaserGRBL

Click File > Open File to add the design you want to engrave. Set the

Quality to 20 Lines/mm (quality has two values options,

20Lines/mm or 10Lines/mm. For those who require high precision,

it can choose 20Lines/mm. For those who require high efficiency, it

can choose 10Lines/mm). Click Next then refer to the parameter
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table to set the appropriate engraving power (S-MAX) and speed.

Please note that the laser mode should be selected as M4-Dynamic

Power, and the value of S-MAX should be 10 times the target laser

power. For example, if the laser power is set to 100%, S-MAX should

be set to 1000%; if the laser power is 60%, set S-MAX to 600%. Next,

adjust the size of the image to scale the design. If the design

position falls outside the working area, you can set the XY axis offset

to adjust the graphic's position.

After successfully importing the graphics and setting the parameters,

it needs to set the focus of Ray6mini, focusing with the focus block,

then click Frame button to determine the material

placement, and finally click Start button to start engraving.

For more detailed information on LaserGRBL software operations,

https://lasergrbl.com/usage/.

https://lasergrbl.com/usage/
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D.LightBurn Software Operation

LightBurn is a professional layout, editing, control, and paid

software for engravers, compatible with Windows, MacOS, and

Linux. It offers a 30-day free trial period. Please remember to save

or back up your data regularly to avoid data loss; however, Rosewill

is not responsible for any data loss caused by third-party software.

If the software has been installed previously, or if the 30-day trial

period has expired, you will need to purchase a license key to

continue using it, according to LightBurn’s trial policy. To purchase a

license and obtain your key code, please visit the LightBurn online

store and select the "GCode License Key".

1. Software Download and Installation

Download LightBurn from the following link:

https://LightBurnsoftware.com/pages/download-trial to install the

trial version of LightBurn.

https://lightburnsoftware.com/pages/download-trial
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For Mac users, after downloading the .DMG file, double-click it and

drag LightBurn into the Applications folder. When launching

LightBurn for the first time, open a Finder window, navigate to the

Applications folder, hold the Control key, and click the LightBurn

icon. From the menu, select 'Open' . When MacOS prompts you to

confirm if you want to open the program, click Yes. It will then be

listed as an exception in your launcher, and you can launch the

application normally from there.
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2. Import Configuration File

Before using LightBurn with Ray6mini for the first time, you need to

import the Ray6mini.lbdev configuration file.

When launching LightBurn for the first time, the 'New Device

Wizard' will appear. If not, click Devices in the Laser control module

to manually import the engraver. Click Import, select the

Ray6mini.lbdev file, and click OK to add the configuration to

LightBurn. Once successfully imported, the macro commands will

appear in the Console window, and Ray6mini will be listed under

Devices in the Laser window.



www.rosewill.com techsupport@rosewill.com27

After adding the device, it is recommended to set the speed unit to

mm/min. To do this, go to Edit in the taskbar, select Settings, choose

mm/min as the unit, and click OK.

3. Connect the Ray6mini to LightBurn

To use LightBurn, the engraver must be connected to the software

first.

For Windows, right-click This PC and select Manage, then click

Device Manager. Expand Ports (COM & LPT), find the port
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corresponding to the CH340 driver, and manually select it in

LightBurn by clicking (Choose) in the Laser window.

For MacOS, go to About This Mac > Overview > System Report, then

select USB under Hardware. If the driver is installed automatically,

USB Serial will appear. In LightBurn, select cu.wchusbserial by

clicking (Choose) in the Laser window.

4. The Main Window of LightBurn

The default layout of the LightBurn main window includes several

key sections: Menus, Main Toolbar, Creation & Modifier Tools, Color

Palette, Cuts/Layers, Laser Window, Move Window, and more.
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Menus: The menu bar at the top of the main window provides

access to almost every feature available in LightBurn, like File, Edit,

Tools, etc.

Main Toolbar: The main toolbar in LightBurn provides quick access

to commonly used functions, such as opening or importing files,

saving, using the clipboard (copy & paste), and moving or zooming

the view. Right beside it is the Arrangement toolbar, which contains

frequently used tools for arranging and aligning shapes.

Tooltips: If you hover the mouse over a control, a small bit of text

will pop up to describe that button or feature. For example, in the
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Creation & Modifier Tools,

and Color Palette, these colors are used to assign different

parameters to the shapes in your design. If a design is selected,

clicking a color entry will apply that color to the shapes in your

selection. The colors currently in use in your design will also appear

as entries in the Cuts / Layers window, where you can choose the

operations each color will represent.

Cuts / Layers: The first column shows the name you've assigned to

this layer, followed by the color, Mode (Line, Fill, both, or Image),

and then the speed and power settings. It also shows the options to

enable or disable sending this layer to the laser or displaying it in

the workspace. Below the layer list, you can see and change the

basic settings for the currently selected layer. Double-clicking an

entry in the layer list will bring up a larger Cut Settings Editor with a

more complete set of options.
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Line mode Fill mode

Double-clicking an entry in the layer list will bring up the full Cut

Settings window, allowing you to edit all the settings. There are

three modes commonly used: Line, Fill, and Image.

In Line mode, the laser follows the exact path of the selected design,

tracing the lines with the beam enabled at the set power and speed.

If the laser moves quickly or with low power, it will likely etch the

surface. If it moves slowly and with high power, it will cut through

the material. The difference between surface marking and cutting is
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primarily in the power and speed settings.

Fill mode allows the laser to scan line by line to fill in the selected

shape. This mode fills closed shapes but not open ones.

Image mode is specifically for images and controls how LightBurn

renders the image data on the laser. There are three commonly

chosen image modes: Atkinson, Stucki, and Jarvis.

Laser Window: The Laser Window is used to select the active

machine, test the framing (the artwork's outer bounds), run and

stop the machine, and choose the file processing, order, and

artwork positioning within the workspace.
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There are two Frame buttons used to preview the position of the

job on the laser. The first is a standard rectangular frame, also

called a 'Bounding Box'. This is the smallest rectangle that will fully

contain the selected shapes. The second is O-Frame button,

also known as the ‘ Rubber Band Frame, ’ which traces a path

around the selected design, similar to a rubber band stretched

around it. The speed and laser power during framing can be

adjusted in the MOVE window. Due to software limitations, the

maximum speed during framing is 12,000 mm/min.

These two different frame effects are illustrated in the following

figure:

Rectangular frame O-Frame
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Console Window: The Console window displays messages from the

controller and commands sent to it by LightBurn, and some macro

commands designed for Ray6mini engraver. You can also input

direct commands to the engraver through this window, such as

$$ to display GRBL settings, or $X to unlock the machine if it has

been locked due to an alarm or error. The Console window will also

display alarm or error messages sent by the laser's controller,

indicating any issues with the machine's operation.

5. Create a Project in LightBurn

Generally, creating an engraving task involves importing graphics,

editing them, setting parameters, previewing, framing, and

engraving. For example, to engrave the Rosewill LOGO and cut after

engraving:

Click File > Import or click import icon in the Toolbar to add the

image to LightBurn. Select the image by clicking select icon,

then adjust the image width to 50.00mm. The height will
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automatically adjust in proportion to the width.

Click Create rectangle. Then, click to unlock and set the

rectangle's width to 55.00mm and height to 12.00mm.
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Click Select button, hold down the Shift key on the keyboard,

select both the rectangle and image, and click Align Center

button on the toolbar to center-align the image and rectangle.

Set the coordinate point to the center of the image and enter the XY

position coordinates as 65, 70 to move the design to the center of

the working area.
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Click on different layers in the Cuts and Layers window to set the

corresponding parameters, and disable Constant Power Mode

(Please note : For image or fill engraving, the Y interval is 0.05mm

The Y interval has two options: 0.05mm for high precision or

0.10mm for high efficiency. ) Adjust the specific parameters

according to the actual materials and parameter table. Then, adjust

the focus of the Ray6mini and click Frame button to confirm

the engraving placement. Finally, click Start .
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6. Connect Ray6mini to LightBurn via Wi-Fi

There are two modes available for connecting the Ray6mini to

LightBurn via Wi-Fi: STA mode and AP mode. The main difference is

that in AP mode, the computer does not have network access, while

in STA mode, the computer can maintain its network connection.
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1) Connect Ray6mini to LightBurn via Wi-Fi in AP Mode

Run LightBurn and connect your PC to Ray6mini. In the Console

window, click ‘AP’ to set the Wi-Fi to AP mode. Next, connect your

computer to the Wi-Fi network that starts with LongerLaser_XXXX

and enter the password 12345678.In the Laser window, click

Devices, select Ray6mini, then click Edit > GRBL > Next >

Ethernet/TCP > Next, then input 192.168.0.1 > Next > Next > Next >

Finish > OK. Click Device Settings , enter 8847 in the Network Port

field, and click OK

OK.
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11
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2) Connect Ray6mini to LightBurn via Wi-Fi in STA Mode

Run LightBurn and connect your PC to the Ray6mini. In the Console

window, right-click ‘STA’ to set the Wi-Fi information, and change

Your_SSID and Your_PassWord to your WIFI account and password
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in $sta/ssid and $sta/password command. Click OK, then left-click

‘STA’ to switch to STA mode. Once the connection is successful, the

console will prompt ‘status = connected’ along with the IP address.

Please note that both your computer network and Wi-Fi must be on

the same Local Area Network (LAN). In the Laser window, click

Devices, select Ray6mini then click Edit > GRBL > Next >

Ethernet/TCP > Next , then input the IP address > Next > Next >

Next > Finish > OK. Click Device Settings, enter 8847 in Network Port

field, and click OK.
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E. LaserBurn Software Operation

LaserBurn is a powerful laser engraving host computer software

designed for laser engraving enthusiasts and professional users.The

software provides an intuitive user interface, including

comprehensive drawing tools and layer management system, which

can meet various complex engraving needs.

LaserBurn supports a variety of laser device connection methods,

including USB serial port and network IP connection, and has

complete device control functions such as laser focus, height control,

frame preview, etc.In terms of engraving operations, the software
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provides real-time preview, progress monitoring and time

estimation functions, and supports pause and continue operations

during the engraving process.

LaserBurn is committed to providing users with efficient and precise

laser engraving solutions, making it easy for both beginners and

professional users to get started and unleash their creativity.

1. Software Download and Installation

Download LaserBurn from the following link: https://www.

For Windows :

https://lightburnsoftware.com/pages/download-trial
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For MacOS :
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2. The Main Window of LaserBurn

a) menu bar

Functional Overview：supports project operations (create, delete projects,

etc.), file management (import and export) and software settings
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 File

 New：create a new sculpting project

 Open：open an existing engraving file

 Save：save current project

 Save as：save the project as a new file

 Firmware Upgrade：supports flashing the latest firmware

 Import：import external files (supports multiple formats)

 Export：export current project

 Exit：close software

 Edit

 Undo：undo the last operation

 Redo：redo an undone action

 Select All：select all elements

 Inverse Selection：invert selected element

 Cut：cut selected elements

 Copy：copy selected elements

 Paste：paste the copied element

 Delete：delete selected elements

 Vectorization：vectorize the selected image

 Settings

 Software Settings：adjust basic software parameters

 Machine Settings：configure laser engraving machine parameters
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 Unit Settings：switch between mm/inch

 Language Settings：switch interface language

 Serial Port Tool

 Serial Port Debugging：send debug command

 Serial Port Logs：view communication records

 Info

 About Software：view software version information

 Local Logs：view the operation log

 Feedback：submit usage feedback

b) Top Toolbar

Functional Overview：provides commonly used editing functions for

elements and quick switching of units

 Basic Operations

 Undo/Redo：quickly undo or redo an action

 Zoom To Fit The Page/Selected Area：quickly locate the

selected element or the entire canvas

 Element Operations

 Offset：adjust element position

 Array：creating an array of elements

 Merge：merge multiple elements

 Combine：combine multiple elements into one element

 Split：split composite elements



www.rosewill.com techsupport@rosewill.com53

 Align：aligning multiple elements

 Flip：flip element horizontally/vertically

 Unit Quick Switch

 Millimeters(mm)：use millimeters

 Inch(inch)：use inches

 Modifying Element Properties

 Position：adjust the coordinate position of the element

 Size：resize elements

 Rotate：rotate element angle

 Corner Radius：adjust the size of the corners of rectangular

elements

c) Right Toolbar

Functional Overview：main area for managing layers, devices, engraving

tasks, etc.

 Layer

 Layer Management：create, delete, and sort layers

 Layer Properties：set engraving parameters

 Layer Lock：lock/unlock layer

 Layer Hide：hide the engraving layer,the hidden layer does not

participate in engraving.

 Device

 Device Connection：connect/disconnect device
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 Device Management：storage management of connected devices

 Device Status：check the device operation status

 Device Control：control device movement

 Device Files

 File Management：deleting files

 File Execution：start carving task

 Engraving History

 History：view engraving records

 Re-carving：repeat historical tasks

 Records Management：delete history

d) Drawing tools Bar

Functional Overview：provides the drawing tools you need to create and

edit engraving content

 Select

 Frame Selection：select multiple elements

 Click：select a single element

 Drag

 Drag：drag the canvas position

 Pen

 Free Drawing：draw freehand lines
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 Line Drawing：draw a straight line

 Curve

 Bezier Curve：draw smooth curves

 Edit Nodes

 Adjusting Nodes：adjust the curve shape

 Shape

 Rectangle：draw a rectangle

 Ellipse：draw a circle

 Polygon：draw a polygon

 Triangle：draw a triangle

 Image

 Importing Images：import external images

 Image Editing：adjust image properties

 Image Vectorization：convert images to vector graphics

 Text

 Add Text：enter text content

 Text Attributes：set font, size, etc.

 Text Layout：adjust text layout
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 Barcode

 QR Code：generate QR code

 Barcode：generate barcode

 Material

 Material Library：manage engraving materials

 Add Materials：importing new materials

 Material Application：using material elements

3. Connect the Ray6mini to LaserBurn

a) Focus on device toolbar

b) Click on the ‘device’ in the device toolbar
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c) Select the Ray6mini image and click Confirm

d) Click the ‘Connect’to open the device connection page



www.rosewill.com techsupport@rosewill.com58

e) After selecting the serial port or IP mode, Click the ‘Connect’to

connect the device

- Port：the system will automatically select the first engraving

machine found

- Baud Rate：the default baud rate of the engraving machine is

921600, which can be changed in the settings

- IP：before network configuration, the default IP address of the

machine is 192.168.0.1

4. Create a Project in LBurn

a) Select drawing tools to create graphics on canvas
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b) Click the selection area to set basic parameters such as speed, power and

laser type switching.
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c) After setting, you can start engraving
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F. APP Operation

1. Download and Installation

To download the LaserBurn app for Android, search for "LaserBurn"

in Google Play or visit the following link:

https://play.google.com/store/apps/details?id=com.longer.longerlas

er&hl=en_US

For iOS devices, search for "LaserBurn" in the Apple App Store or

visit the following link:

https://apps.apple.com/us/app/laserburn/id6451089363

Alternatively, you can download the app from Rosewill’s official

website:

For complex grayscale engraving, it is recommended to transfer

the image to your mobile phone’s album and then import it into

the app for engraving, as this method tends to produce better

results.

https://play.google.com/store/apps/details?id=com.longer.longerlaser&hl=en_US
https://play.google.com/store/apps/details?id=com.longer.longerlaser&hl=en_US
https://apps.apple.com/us/app/laserburn/id6451089363
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2. Connect to Wi-Fi in AP mode

Note: There are two modes, AP and STA, for connecting the

Ray6mini via Wi-Fi. The key difference is that in AP mode, the

phone will lose internet access, while in STA mode, it can stay

connected to the network.

1) Run the LaserBurn app and go to the Home page. Click the not

connected icon . When prompted with ‘ Allow

LaserBurn to access this device?’ , select ALLOW ONLY WHILE IN

USE to ensure the app can search for the Ray6mini's Wi-Fi network.

2
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Open your phone’s WLAN settings, search for the Wi-Fi network

starting with LongerLaser_XXXX and connect using the password

12345678 . Then, enter the IP address 192.168.0.1 , click Connect,

and wait for the "connection succeeded" confirmation message.

3. Connect to Wi-Fi in STA mode

1) Open your phone’s WLAN settings. Run the LaserBurn app, go to

the Home page, and click the not connected icon , to

enter the network configuration page. Click Add in the upper
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right corner.

2) Select the Ray5 mini/Ray5 miniS image and click Confirm.

3) Click Scan device, search for the WIFI network starting with

LongerLaser_XXXX，and connect using the password 12345678 .
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4) Once connected, return to LaserBurn and select Set STA mode to

connect the Ray6mini to a router (supports 2.4G only). Enter the

router ’s password. The indicator light on the front of the Ray6mini

will turn orange (breathing light) while connecting and switch to

green if the connection is successful. If the connection fails, the

indicator will remain orange, and you will need to restart the

process from step 1).

4
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5

6

5) Return to LaserBurn, click Connect network at the bottom of the

page, and ensure your phone is connected to the same Wi-Fi

network as set in STA mode. Wait for network configuration to

complete. When the connection is successful and the progress

reaches 100%, click FINISH to return to the device list.

Note: Once the device is connected, clicking anywhere on the

device list will disconnect it. Conversely, clicking when disconnected

will automatically reconnect your phone to the device.
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4. Creation
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In the creation interface, you can import graphics through various

methods, including drawing, text, QR codes, photo albums, cameras,

material library, etc.

1) Draw

Draw simple images, such as circles, rectangles, triangles, etc.

Enter a value in Size to scale the graphic proportionally or hold

down the button to drag. If you need to adjust the length and

width separately, click the button to unlock the proportional



www.rosewill.com techsupport@rosewill.com69

lock. Enter a value in Position to change the Graphic ’s position, or

select and move it within the canvas by dragging. Enter a value in

Rotate to rotate the graphic counterclockwise to the corresponding

angle, or hold down the button to rotate it freely. If you click

the button , the size, position or angle of graphic can only be

changed by entering a value. Clicking the button will delete the

graphics.

2) Text

Enter text and adjust the font, text size, position and angle.
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3) QR code

Generate a QR code based on the input content and adjust its size,

position, or angle.

4) Layer

Layer mode: Set line or fill

Laser type: Choose from 2.5W or 3.5W 450nm Blue light

Processing method: Engrave or cut

Material: Choose the corresponding material from the material

library, and the app will automatically set the appropriate
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parameters based on the selected processing method and laser

power. If adjustments are needed, click the edit button to modify

the settings.

Different colored layers allow you to set specific parameters for your

design, enabling you to engrave or cut multiple files simultaneously.

You can customize parameters such as layer mode, laser type,

processing method, material, laser power, speed, number of passes,

and accuracy. Up to 11 parameters can be set in the app. To set the

parameters, select the design, click Layer, and choose the
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corresponding colored layer.

5) Album

Import pictures from your mobile phone album.

6) Camera

Use your phone’s camera to take pictures and import them into the

app.

7) Undo

Undo the last operation The app supports up to 20 steps of
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undo.

8) Redo

Redo the last undone operation. The app supports up to 20

steps of redo.

9) Clear

Clear all graphics from the canvas.

5. Files

When connected to the engraving machine, you can preview the

files uploaded to the Ray6mini. To delete a file, select it from the list

and slide it to the left. When the available memory is nearly full,

please delete unnecessary files to ensure new files can be

uploaded.

6. History

The History section displays a list of graphics from previous

operations on the app. To delete unwanted images, simply
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long-press a file in the list.

7. Material

The Material section is the graphic library within the app. To add

graphics, click the ADD button in the upper right corner to import

from your phone's album or memory. You can find your uploaded

pictures in the Mine menu and click the cross in the upper right

corner of the picture to delete it, but built-in images cannot be
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deleted.

8. Create a Project in LaserBurn APP

1) Run the LaserBurn app and connect it to the Ray6mini. Add a

graphic, click Edit to set the size and position, then click Layer to

adjust the graphic parameters. After setting, click next in the upper

right corner.

There are 4 values for accuracy: Ultra Fine, Fine, Fast, and Ultra Fast.

The default value is Fine. For more precision, select Ultra Fine. For

more efficiency, select Fast or Ultra Fast.
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2) Click Border setting to set the speed and patrol power. After

setting, click frame to patrol the border. After confirming that the

engraving position is correct, click Start to start engraving.

3) Once you ’ ve confirmed the focus is properly adjusted and

goggles are worn, click Confirm to confirm the file name. The file

will then upload to the Ray6mini. After the upload is complete, click

Confirm to start the engraving task.
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4) The app will display the task progress. You can click Pause to

pause the task or click Stop to cancel it. When the task is completed,

a 'Work completed' prompt will appear. Click Confirm to return to

the Home page.
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